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1 Compatibility with older versions 
 
Before staring the manual user should be notified about compatibility with older versions of the Display 
Studio. Displays with the newer embedded software will be compatible with older versions of the Display 
Studio 3.xx until July 2011. That means that older DDS files will be usable for the displays released until 
this date. New Display Studio 2011 is compatible with older versions of displays, so the user can upload 
and download DDS files built with new Display Studio 2011. With new Display Studio 2011 user can 
download display content uploaded with older version of Display Studio such as 3.xx and lower. 
 

2 Getting started 
 
Display Studio 2011 application is intended for design of textual and graphical information that will be 
displayed via LED displays. There is also a preview or simulation, so user (designer) is fully independent 
of real display. Prior to making display project, if display is connected to PC, it is recommended to 
connect to display using option Get from display as described in Connecting to Displays, so display 
properties (pixel width, pixel height etc.) will be used from display. In case DDS file made for current 
display is opened, display properties are also updated. Otherwise, display properties should be manually 
set. 

 
2.1 Main Window 

 
After Display Studio 2011 is opened, it starts with blank project. Project encapsulates the whole variety 
of data that could be displayed on LED displays. Project file format has extension dds. User can load 
previously saved project using File/Open, or via   toolbar button. Picture bellow shows application 
main window just after launching. Workspace is divided to Elements tree view which is used for 
selecting type of media or fonts, Library containing media of each type and Project time line and Font 
containing lists and fonts used in project. 
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2.2 Elements 
 
As was mentioned earlier, tree view on the left-hand side of the main window is intended for navigation 
through the content that is stored in the library for use with display. Project data categorization could be 
described as:  
- Animations – all animations in the library. 
- Images – all images in the library that can be used as static images. 
- Texts – text elements for displaying all kinds of text (static, rolling, date, time, temperature) 
- Wipes – all wipes currently assigned to project. A purpose of a wipe is an effective animated transition 
from previous image into new image. When user inserts a wipe between two elements, whether it was 
animation or textual element, this will make transition effect into the first frame of next element. A series 
of frames of this animated transition is defined using the rule that white pixels mark pixels from previous 
image that will be shown and black from new image. In other words, wipe, as we see it as a standalone 
animation, is a wipe from white to black. 
- Fonts – all fonts added to the library 
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2.3 Library 
 
User can see library content in the Library. Elements are inserted in the selected list of the time line bar 
by double clicking on the desired element or by dragging and dropping it. To insert new media or font to 
the library user should right click on the library window and select Add Element property or by drag and 
drop from other window. Media or font can also be exported, removed, renamed and edited by using 
appropriate options from context menu strip. 
 

 

3 Lists 
 
Time line and fonts bar are located in the bottom of the window. The time line contains the lists with 
content that is going to be uploaded to display. Each list contains elements. New project contains one 
blank list, Main List. New lists are added using menu option Project/Add New List or by clicking the 
icon . Selected list is removed by using option Project/Remove List or by clicking on icon .  Also by 
right clicking on list name there is menu shown for adding, removing and renaming of lists. List can 
also be renamed by double-clicking on list name. Adding elements from the library to the list is done by 
double clicking on the element or by dragging and doping it in the desired position in the list. The 
position of the element in the list defines the time when the element is going to be displayed. The order 
of the lists can be manipulated by dragging the list to the desired position. Each element can be edited 
by opening properties window or removed from the list. 
 

3.1 Populating the list 
 
As we mentioned, the list is populated with elements from the library. User, when adding elements, 
enters the properties of the element such as: duration, frame rate, loop, and other functions. If user 
needs to reorder the elements added to the list it can be done by dragging the element to the desired 
position. Also there are cut, copy, paste and delete options from context menu strip or by classic 
keyboard commands (Control + X, Control + C, Control + V and Delete). 
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3.1.1 Text elements 
 
Text elements are intended for displaying text information, like static text, rolling text, current time, date, 
temperature etc. Element properties are shown when placing the text element in the list or by double 
clicking on the text element in the list or by right-clicking from menu choosing option Properties. Text 
element properties are: 
Add Background – adds a background image for the text that is displayed behind the text. 

Remove Background  - removes the background image 

Add Text   - adds a text to display 

Add Time  - shows the time on display 

Add Date  - shows the date on display 

Add Temperature - shows the temperature on display 

Remove Object  - removes object from display 

Center Object  - center object to middle position of display 

Zoom plus  - zoom in display pixels 

Zoom minus  - zoom out display pixels 
 
 
Name – Name of element 
Duration – Duration of the element appearance on the display (in 100ms), i.e. Duration = 10 means that 
element is going to be displayed 1 sec.  
Loop - define how many times the element will be displayed  
Loop after wipe – If there is wipe before this element , wipe will also be displayed before element. 
   
Because of the possibility of the text element to have multiple texts, every text has its own property that 
is editable by clicking on the text that needs to be configured. Texts properties are:  
 
Text – Current text that needs to be displayed. User can write any text in this field. 
Font – Font of the current text. The property is displaying only fonts inserted in font list. 
Zoom - Represents text zooming and takes integer values between 1 and 4. 
Left and Top – Defines the position of the text relative to upper left corner. Properties Left and Top can 
be changed by dragging and moving object in the panel view. 
Blinking – if property is on, text will appear for the time defined by Duration property and despair for the 
same amount of time.  
Rolling text – if checked, text will roll. 
Rolling speed – rolling speed in frames per second 
Rolling type – choose from roll right to left, left to right etc. 

 
User can place the text at desired position of display by moving the object. Also there is a Center 
Object button that can automatically position text in the center. 
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3.1.2 Image elements 
 
Image elements are used to display a static image on the display. User can insert the image elements to 
the Timeline by double clicking on the element in the library list, or by dragging and dropping it to the 
desired location. User can insert new image elements to the library by selecting the Image from the 
elements tree, right clicking in the library window and clicking on the Add Element property or by drag 
and drop from other window. Supported formats are .bmp, .jpg, .png and .gif. There is always the 
conversion from color to black&white performed when the image is imported, so user can use color 
images also. Element properties are shown when placing the image element in the list.  
 
The parameters defining the inserted image element to the list are: 
Freeze – Duration of the element appearance on the display (in 100ms), i.e. Freeze = 10 means that 
element is going to be displayed 1 sec. 
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3.1.3 Animation elements 
 
Animation elements are used for displaying animation. User can use animation from the library, or can 
import existing animation from file (avi and gif file format). This is done by right clicking in the library 
window and selecting the Add Element property or by drag and drop from other window. Same as 
image importing there is conversion from color to black&white so user can use color animations also. 
Inserting animation in the list is done in the same way as other elements. Animation element properties 
are: 
Frame rate (fps) – playing speed in fps (frames per second) 
Freeze – duration of last frame in tenths of a second 
Loop - define how many times the element will be displayed 
Loop after wipe - If there is wipe before this element , wipe will also be displayed before element 
 

 
 



  
Display Studio 2011 
 
 

   

 Page 10 
 
 

3.1.4 Wipe elements 
 
A purpose of a wipe is an effective animated transition from previous image into next image. When user 
inserts a wipe between two elements, the last frame from previous element, whether it was animation or 
textual element, will make transition effect into the first frame of next element. A series of frames of this 
animated transition is defined using the rule that white pixels mark pixels from previous image that will 
be shown and black from new image. In the other words, wipe, as we see it as a standalone animation, 
is a wipe from white to black. Inserting the Wipe in to the library is the same as inserting animation 
element. Adding the wipe in to the list is somehow different from the adding ordinary element, because 
of the fact that user cannot insert wipe at the end of the list, or insert two wipes in the row. Valid insertion 
of the wipe is only between two elements.   
The property of the Wipe element is Frame rate (fps) that defines the wiping speed in fps (frames per 
second). 
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4 Fonts 
 

4.1 Adding fonts to the library 
 
User can import fonts from DNT file to the library by selecting the font element from the element tree, 
right clicking on the library window and selecting the Add Element property or by using drag and drop 
from other window.  When fonts are present in the library use needs to add them to the Font list so these 
fonts can be used for texts inserted in the list. Fonts in library can be reordered, removed, renamed and 
edited. 
 

4.2 Font list 
 
Fonts added to the Font list can be used for building texts in the text elements. Fonts in font list can also 
be reordered and removed. 
 

 
 

4.3 Font editor 
 
Font editor is used for editing of fonts. With right mouse click on font element in library, select Edit Font. 
New window will appear, called Font Editor. 
 

 
 
From the File menu, there are several options: 
Compare Fonts – for compairing two fonts 
Save Font – overwrite current font 
Save Font as new – save current font as new with different name 
Rename current font – change name of the current font 
Delete current font – delete current font from library 
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Import Dnt font – Import font in dnt format. (dnt is unique file format for bit-mapped fonts. Every font 
that is created with Display Studio is saved in dnt format).  
Import Windows font – import existing font from installed Windows fonts. 
Export dnt font – export current font as dnt file. 
Exit – close Font editor. 
 

 
 

 
 
There are several options for current font. 
Font – select font for editing, only dnt format 
Encoding – choose Windows encoding, standard software support Central European, Cyrillic, Western 
European, Greek, Turkish, Hebrew, Arabic, Baltic and Vietnamese encoding. 
Proportional  - if this option is checked, font will be proportional, which means every character can have 
different width, if this option is not checked, font is unproportional, meaning all characters have equal 
width. 
 
Width – width of font character (if not proportional, all characters have equal width) 
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Height – height of all font characters 
Last character – set number of characters in font, can be from 0 to 255 
Shift font characters – there are four arrows: Up, Down, Left and Right. On every left mouse click on 
one of arrows, all characters from font will be shifted in direction set by arrow direction. When font 
shifting is finished, just click Apply.  
Widest character – describes the widest character in current font and its width and position. 
Character preview and drawing field – when you click on some character, it will appear in this field. 
You can edit every character in this field, using Hand and Pencil.  
Hand – when selected, you can move whole character in all directions. 
Pencil – when selected, with left mouse click you can add pixels to character, with right mouse click you 
can delete pixels from character.  
 
Bellow each character is its unique sign, showing how that character looks in chosen encoding and also 
its decimal and equivalent hex number in the font. 
 

4.3.1 Compairing fonts 
 

 
 
User can compare two fonts by selecting Compare Fonts from File menu. Option Scroll fonts 
simultaneously is automatically selected so both fonts are scrolled at same time so user can see 
coresponding characters all the time. 
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5 Media editor 
 
For editing library elements, such as Animations, Images and Wipes, user can open Media Editor from 
menu Project->Media Editor or by right-clicking on the element that needs to be changed and selecting 
Edit Media. 
 

 
 
In the Media Editor menu user can select the type of media (Animations, Wipes or Images). After 
choosing media type user can select existing media from the library, make new media or import media. 
Also media can be saved after editing over old one or as new, renamed or deleted. Media can be also 
exported to corresponding format (jpg and bmp for images, avi and gif for animations and wipes). 
Work space has 3 areas.  
 
1. Area on the left shows list of all frames of current media. Plus and minus buttons are for adding and 

removing of frames. When user clicks on + button blank frame is added after current frame. When 
clicked on – button all selected frames are removed. One frame is selected by clicking on it, multi 
frames are selected by holding Shift keyboard key and clicking on first and last frame so all frames 
between are selected. Right clicking on frame gives context menu strip with functions cut, copy, 
paste and delete. There are also Export frame as Image for exporting selected frames to selected 
folder as images and Import image as frame for importing images to frame list after selected frame. 

2. Lower area is for real-time preview of media and has play, frame by frame and stop buttons and 
also a slider for changing current frame for preview. There is a frame rate selection for preview.  

3. Upper area is for frame editing. There are basic functions for picture editing such as drawing (pencil 
icon), fill (bucket icon), selection of area of frame for copying, cutting or moving (selection icon), 
move selected area (hand icon), draw text (text icon), undo and redo functions and zoom in and 
zoom out. In upper right part of area there are two buttons which shows the current colors of display. 
The left color is associated with left mouse button and right with right mouse button. So if user wants 
to draw with left color user should use left mouse button and if want to fill area with right color, right 
mouse button needs to be used. 
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6 Preview 
 
Trough the building process of the content that needs to be uploaded to the display user can always 
preview content by clicking on the icon  from toolbar. There are standard buttons for playing of 
preview (play, frame by frame, skip, pause and stop buttons). 
 

 

7 Connecting to Displays 
 
For establishing communication with the display, basic project parameters must be set. Because of the 
fact that Display Studio 2011 can communicate to more than one display simultaneously, user should 

first select the display mode of communication by clicking on the icon . There are three display 
modes: 
Single Display – communicating with single display only 
Split Display – user can stack smaller displays with equal resolutions to build larger one. 
 

 
Multi Display - user can upload same content to more displays at once.  
 
After choosing the working display mode user should set connection type and the display properties by 

going to Display/Connect to Display or clicking on the icon . 
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7.1 Single Display mode 
 
In this mode content is going to be uploaded only to one display. After entering Display properties user 
can set following options: 
 
Serial Port - communication via serial port, form drop down list choose COM port. 
Ethernet (LAN) – communication via Ethernet (LAN) , where user can search for the available displays 
connected to LAN by pressing Search button 
Display IP address – user can choose IP address of device from combo box after pressing Search 
button. 
Get from display – automatically reads properties from display and sets properties to match connected 
display. Properties are display width, height and active panel format. Also if specified, width of vertical 
segments, height of horizontal segments, color of display pixels and shape of display which can be 
rectangle or cross. User can also set properties as desired. 
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7.2 Split Display mode 
 
Split Display mode gives user ability to build a higher resolution display by combining few smaller 
displays. Uploading content in this mode is only available for displays connected to LAN. When entering 
the display properties user can set following options:  
 
Search Display – search for the available displays on the LAN 
Display matrix section: 
Vertical Displays – sets the number of vertical displays 
Horizontal Displays – sets the number oh horizontal displays 
Effective Display Section: 
Number of displays – number of displays selected 
Effective Resolution Section: 
Width – Width in pixels of the all displays combined 
Height – Height in pixels of the all displays combined 
Display Addresses section: 
In this field user is setting appropriate addresses for every display that is part of split display 
Display Resolution section: 
This section describes common properties for each display that is part of split display. 
Width – Width in pixels of each display 
Height – Height in pixels of each display 
Get From Display - automatically set display width and height to match connected display. Also if 
specified width of vertical segments, height of horizontal segments, color of display pixels and shape of 
display which can be rectangle or cross. User can also set properties as desired. 
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7.3 Multi Display mode 
 
Multi Display mode gives user ability to upload same content to more displays at once. This mode is 
also working with displays connected to LAN. When entering the display properties user can set options 
related to display: 
 
Search – search for the available displays on the LAN 
Number of displays – number of displays selected 
Display Addresses section: 
In this field user is setting appropriate addresses for every display. 
Display Resolution section: 
This section describes common properties for each display. 
Width – Width in pixels of each display 
Height – Height in pixels of each display 
Get From Display - automatically set display width and height to match connected display. Also if 
specified width of vertical segments, height of horizontal segments, color of display pixels and shape of 
display which can be rectangle or cross. User can also set properties as desired. 
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7.4 Write to display(s) 
 
Loading content into display is launched by option Display/Write to Display(s) or by corresponding 
toolbar icon .  
 
Write to Display – starts writing project to display.  
Verify – upon uploading the display, if this option is checked, uploaded content (in display memory) is 
verified (compared) with uploaded project from Display Studio 2011. 
 

 
 

 
7.5 Read from display(s) 

 
To load content from display(s) start option Display/Read from display(s) or by corresponding toolbar 
icon .  
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8 Remote control 
Remote control is used for controlling real LED display. It has following functions: 
  

 
 
Play  - starts playing 
Stop – stops playing and turns display off 
Pause  - Pauses playing 
Frame by frame – toggles frame-by-frame playing mode. When this mode is on, clicking on Play 
command shows next frame.  
Skip – skips to next panel 
Reset – Reset the display. 
Insert list – Insert selected list, when list is finished, playing continues with active list 
Set list – sets selected list as active 
Set time – adjusts display time to PC time 
 

Remote control is activated with Display/Remote control or by  button on taskbar. 
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9 List scheduler 
User can define time/date of list activation using list scheduler option (Project/Scheduler). 
Procedure for scheduling lists is: 
 
Enter list activation date in field Date. If Repeating button is activated, list can be activated/inserted 
everyday, on workdays, on weekends, on Mondays, on Tuesdays etc.. 
Enter list activation time in field Time. 
Pick a list in List field. 
Choose list activation method – Insert selected list (list content is displayed once, after that previously 
displayed list continues) or Set selected list as active (list content loops until some other list is set 
active). 
 
Press Add button. List activation info appears in list below. Existing list schedules can be removed using 
Remove button. 
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10 Display parameters 
 
User can see or even edit some display parameters. To list all parameters use menu option 
Display/Display Parameters. Some of the parameters relates to display work (like Working Hours, 
Number of Resets or Time of the last reset), some relates to hardware display configuration (Height, 
Width, Flash disc size...), some to specific software features (CR force LF, Special start number ...) etc. 
Number of parameters and their values depend on display. Generally, parameters can be separated in 2 
groups. First are editable, second non editable parameters. In the DisplayStudio2011 parameters are 
grouped by type (General, Memory …). Grouping by type brings easier way of parameters manipulating. 
Display Studio 2011 introduce parameter saving option as well as saving tables such as Event logs, 
Brightness regulation table, Temperature logs and so on, from dislpay memory to Excel file format. Upon 
setting parameters, user can save current parameters setting by pressing Save button. Parameters are 
saved in Excel file that can be opened from Excel.  
 

 
 
As we mentioned, Display Studio 2011 is capable of saving display parameters and tables from display 
memory to the template in Excel format. User can use template Excel file provided with current display 
to save and preview data. Tables are usually some logs that device collect during its work like 
“temperature log” with minimal and maximal temperature every day or “event log” that inform about 
important events or “short circuit and open circuit error data” … 
Select the excel template file by clicking the Save using template button. It is advised to select the 
template file that comes with the device so the data can be more readable, but if file is not available an 
empty excel file can be used. After doing these steps user will be notified that data is saved and user is 
given an option to open Excel file to read data. 
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11 Memory Map 
 
Animations, wipes and images, on the display side, are physically located at display flash disk, or as we 
call it display memory. This feature is used to define and manage storing in display memory. By creating 
or compiling of lists, memory reallocation is automatically performed. User can be informed about real 
address in memory display that a particular media is stored at. User can also see the amount of 
consumed memory. 
 

 
 
To see memory map appears use menu option Project/Memory map. Window shows all lists, 
animations, wipes, backgrounds and fonts with exact location in the memory where they are loaded and 
interval of addresses they are using. 
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12 Variables for Timing Devices and Game-Consoles 
You can create an active list which is showing Timing-Data and Names directly from your ALGE Timing-
Device. 

12.1 Variables for Timers 
Received by RS232 or black-yellow banana-sockets. 
 

$ Variable  Describtion 
$D195 Name of the Bib last received 

from names entered from scoreboard software 
$D196 Current Time received from Timing-Device, automatic format, hh:mm:ss.th 
$D197 Current Rank received from Timing-Device 
$D198 Current Bib received from Timing-Device 
$D199 Name of current Bib from Excel-Startlist 
$D200 Nation of current Bib from Excel-Startlist 
$D201 Club of current Bib from Excel-Startlist 
$s000 Name of Player with Bib 001-999 
$sA00 Nationality of Player with Bib A00-A99=000-099; B00-B99=100-199;… 
$sa00 Club of Player with Bib a00-a99=000-099; b00-b99=100-199;… 
$D000-$D194 Byte from Datapacket 

 
12.2 Variables for Game-Consoles D-CKx 

Anzeigelisten die folgende Variablen enthalten zeigen die jeweiligen Informationen direkt auf der 
Anzeige an. 
 

$ Variable  Description 
$B00 Score home – 3 numerals, clear leading zeros 
$B01 Score guest – 3 numerals, clear leading zeros 
$B02 Time minutes 
$B03 Time seconds 
$B04 Time 1/10 seconds 
$B05 Remaining TimeOut Time 
$B06 Home team name 
$B07 Guest team name 
$B08 Guest team name, left alignment 
$B09 Number of fouls for home team 
$B10 Number of fouls for guest team 
$B11 Last player who has committed the foul 
$B12 Foul number for that player 
$B13* 1 point percentage for home team 
$B14* 2 points percentage for home team 
$B15* 3 points percentage for home team 
$B16* 2 and 3 points (field) percentage for home team 
$B17* Number of fouls for home team 
$B18* 1 point percentage for guest team 
$B19* 2 points percentage for guest team 
$B20* 3 points percentage for guest team 
$B21* 2 and 3 points (field) percentage for guest team 
$B22* Number of fouls for guest team 
$B23* Name of the team who has exchanged player(s) 
$B24 Penalty1 home in format  PP mm:ss (PP – player number, mm - minutes, ss – seconds) 
$B25 Penalty2 home in format  PP mm:ss (PP – player number, mm - minutes, ss – seconds) 
$B26 Penalty1 guest  in format  PP mm:ss (PP – player number, mm - minutes, ss – seconds) 
$B27 Penalty2 guest  in format  PP mm:ss (PP – player number, mm - minutes, ss – seconds) 
$B28 Misconduct Penalty home in format  MPP mm:ss    (M – sign for misconduct  

PP - player number, mm - minutes, ss – seconds) 
$B29 Misconduct Penalty guest in format  MPP mm:ss    (M – sign for misconduct  

PP - player number, mm - minutes, ss – seconds) 
$B30 ScoreHome for 1. time period  
$B31 ScoreGuest for 1. time period 
$B32 ScoreHome for 2. time period 
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$B33 ScoreGuest for 2. time period 
$B34 ScoreHome for 3. time period 
$B35 ScoreGuest for 3. time period 
$B36 ScoreHome for 4. time period 
$B37 ScoreGuest for 4. time period 
$B38 Sign for poss home or set home(voleyball) 
$B39 Sign for poss guest or set home(voleyball) 
$B40 Game Period (has value E for extra time period) 
$B41 Number of timeouts for home team 
$B42 Number of timeouts for guest team 
$B43 Shot Time  
$B44 Shot Time or TimeOut (for shoving shot time and timeout time in same place) 
$B45 Penalty home which is start first.  

(when only one penalty per team is shown) (format:  PP mm:ss) 
$B46 Penalty guest which is start first.  

(when only one penalty per team is shown) (format:  PP mm:ss) 
$B47 Minutes of misconduct penalty home when only minutes for this penalty is shown)   

(format: Mmm) 
$B48 Minutes of misconduct penalty guest when only minutes for this penalty is shown)   

(format: Mmm) 
$B49 Score Home  - two digit score (format xx) 
$B50 Score Guest  - two digit score (format xx) 
    
$Hxx* Home player name, xx is player number, can be 00-99 
$H9:* Home coach name 
$H9;* Guest coach name 
$H9<* 1st arbiter 
$H9=* 2nd arbiter 
$H9>* official delegate 
$H9?* Number of spectators 
$Gxx* Guest player name, xx is player number, can be 00-99 
$Pxx* Player name leaded with player number. Depending on xx is: 

0-4 5 Home players currently in the field 
5-9 5 Guest players currently in the field 
10-14 Home players who were in the field 
15-19 Guest players who were in the field 
20-24 Home players who were and who are currently in the field 
25-29 Guest players who were and who are currently in the field 
30-34 Players of the team that exchanged player(s) currently in the game 
40-44 Players of the team that exchanged player(s) were in the game 
50-54 Players of the team that exchanged player(s) were and are in the game 

$hxx Home player name, typed from command console, xx can be 0-11 
$gxx Guest player name,  typed from command console ,xx can be 0-11 
$ixx Home player number, typed from command console, xx can be 0-11 
$jxx Guest player number, typed from command console, xx can be 0-11 
$Mxx Messages typed from command console, xx is message number, can be 00-19 

 
* Those variables are entered from Scoreboard software or Basketball statistic software. 
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13 Tutorial 
 
As a short demonstration of all described above, we will create display contents with 2 textual panels 
with rolling text, which will be divided by a wipe effect. After that, an already created animation (we have 
it in avi file) will also be displayed. 
So, let’s go on with work. Here are project requirements: 
Client wants company logo at the background and rolling text at the bottom of the display. 
Client wants a commercial rolling on the whole display area (maximum possible font size). 
Client has prepared animation he wanted to be displayed. 
In order to work with text we need to add fonts to project. Select Fonts from the Element tree, right click 
in the Library window and click Add Element to choose font file (.dnt). Now select the font bar in the 
bottom of the window and add that fonts to the project by double clicking on them. Now, let’s first import 
client's company logo bitmap to the library. Select Image from the Element tree and do similar with 
importing fonts, right click on the library window and Add Element, in this case the .bmp or .jpg file. Now 
add Animation and Wipe elements to the library as same as you added image logo. Note that Animation 
and Wipe elements should be avi or gif file format. When we have all elements in the library all we need 
to do now is to add them to the Main List in the Time Line bar.  
First select Text from the element tree, and drag the Text element from the Library to the Main List. After 

placing the text element in the list, a property appears. Click on Add Text   , insert desired text in 
the Text field, and position it in the wanted position by moving the text. Check the Rolling text checkbox 

and select the font. Press the Add Background button  and add the background image. Click OK 
button to save changes. Now insert another text element and for the properties select larger font. Next 
go to Animation and drag the animation to the list. Select the frame rate, freeze and loop from the 
properties window. After inserting this elements go to Wipes and drag and drop it between two 
elements. Now you can see the preview by clicking the icon . If everything is looking fine, upload the 
content to display. 
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